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Chapter 1: About this Document

This section discusses the purpose of this document, the conventions used, ways to provide
feedback, additional help, and information regarding other Extreme Networks publications.

Purpose
This document describes how to use the Command Line Interface (CLI) and Enterprise Device
Manager (EDM) interfaces to configure the following products:

• Extreme Networks Ethernet Routing Switch 4900 Series

• Extreme Networks Ethernet Routing Switch 5900 Series

Conventions
This section discusses the conventions used in this guide.

Text Conventions
The following tables list text conventions that can be used throughout this document.

Table 1: Notice Icons

Icon Alerts you to...

Important: A situation that can cause serious inconvenience.

Note: Important features or instructions.

Tip: Helpful tips and notices for using the product.

Danger: Situations that will result in severe bodily injury; up to
and including death.

Table continues…
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Icon Alerts you to...

Warning: Risk of severe personal injury or critical loss of data.

Caution: Risk of personal injury, system damage, or loss of
data.

Table 2: Text Conventions

Convention Description
Angle brackets ( < > ) Angle brackets ( < > ) indicate that you choose the

text to enter based on the description inside the
brackets. Do not type the brackets when you enter
the command.

If the command syntax is cfm maintenance-
domain maintenance-level <0-7> , you can
enter cfm maintenance-domain
maintenance-level 4.

Bold text Bold text indicates the GUI object name you must act
upon.

Examples:

• Click OK.

• On the Tools menu, choose Options.
Braces ( { } ) Braces ( { } ) indicate required elements in syntax

descriptions. Do not type the braces when you enter
the command.

For example, if the command syntax is ip address
{A.B.C.D}, you must enter the IP address in
dotted, decimal notation.

Brackets ( [ ] ) Brackets ( [ ] ) indicate optional elements in syntax
descriptions. Do not type the brackets when you
enter the command.

For example, if the command syntax is show clock
[detail], you can enter either show clock or
show clock detail.

Ellipses ( … ) An ellipsis ( … ) indicates that you repeat the last
element of the command as needed.

For example, if the command syntax is
ethernet/2/1 [ <parameter>
<value> ]..., you enter ethernet/2/1 and as
many parameter-value pairs as you need.

Italic Text Italics emphasize a point or denote new terms at the
place where they are defined in the text. Italics are

Table continues…

About this Document
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Convention Description
also used when referring to publication titles that are
not active links.

Plain Courier Text Plain Courier text indicates command names,
options, and text that you must enter. Plain Courier
text also indicates command syntax and system
output, for example, prompts and system messages.

Examples:

• show ip route
• Error: Invalid command syntax
[Failed][2013-03-22 13:37:03.303
-04:00]

Separator ( > ) A greater than sign ( > ) shows separation in menu
paths.

For example, in the Navigation tree, expand the
Configuration > Edit folders.

Vertical Line ( | ) A vertical line ( | ) separates choices for command
keywords and arguments. Enter only one choice. Do
not type the vertical line when you enter the
command.

For example, if the command syntax is access-
policy by-mac action { allow | deny } ,
you enter either access-policy by-mac action
allow or access-policy by-mac action
deny, but not both.

Documentation and Training
To find Extreme Networks product guides, visit our documentation pages at:

Current Product Documentation www.extremenetworks.com/documentation/
Archived Documentation (for earlier
versions and legacy products)

www.extremenetworks.com/support/documentation-archives/

Release Notes www.extremenetworks.com/support/release-notes
Hardware/Software Compatibility
Matrices

https://www.extremenetworks.com/support/compatibility-matrices/

White papers, data sheets, case
studies, and other product resources

https://www.extremenetworks.com/resources/

Documentation and Training
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Training
Extreme Networks offers product training courses, both online and in person, as well as specialized
certifications. For more information, visit www.extremenetworks.com/education/.

Getting Help
If you require assistance, contact Extreme Networks using one of the following methods:

Extreme
Portal

Search the GTAC (Global Technical Assistance Center) knowledge base, manage
support cases and service contracts, download software, and obtain product
licensing, training, and certifications.

The Hub A forum for Extreme Networks customers to connect with one another, answer
questions, and share ideas and feedback. This community is monitored by Extreme
Networks employees, but is not intended to replace specific guidance from GTAC.

Call GTAC For immediate support: 1-800-998-2408 (toll-free in U.S. and Canada) or +1
408-579-2826. For the support phone number in your country, visit: 
www.extremenetworks.com/support/contact

Before contacting Extreme Networks for technical support, have the following information ready:

• Your Extreme Networks service contract number and/or serial numbers for all involved Extreme
Networks products

• A description of the failure

• A description of any action(s) already taken to resolve the problem

• A description of your network environment (such as layout, cable type, other relevant
environmental information)

• Network load at the time of trouble (if known)

• The device history (for example, if you have returned the device before, or if this is a recurring
problem)

• Any related RMA (Return Material Authorization) numbers

Subscribing to Service Notifications
You can subscribe to email notifications for product and software release announcements,
Vulnerability Notices, and Service Notifications.

1. Go to www.extremenetworks.com/support/service-notification-form.
2. Complete the form with your information (all fields are required).
3. Select the products for which you would like to receive notifications.

About this Document
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Note:
You can modify your product selections or unsubscribe at any time.

4. Click Submit.

Providing Feedback to Us
Quality is our first concern at Extreme Networks, and we have made every effort to ensure the
accuracy and completeness of this document. We are always striving to improve our documentation
and help you work better, so we want to hear from you! We welcome all feedback but especially
want to know about:

• Content errors or confusing or conflicting information.

• Ideas for improvements to our documentation so you can find the information you need faster.

• Broken links or usability issues.

If you would like to provide feedback to the Extreme Networks Information Development team, you
can do so in two ways:

• Use our short online feedback form at https://www.extremenetworks.com/documentation-
feedback/.

• Email us at documentation@extremenetworks.com.

Please provide the publication title, part number, and as much detail as possible, including the topic
heading and page number if applicable, as well as your suggestions for improvement.

Providing Feedback to Us
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Chapter 2: New in this document

The following sections detail what is new in this document.

Timestamp in show command outputs
The output for all CLI show commands includes a timestamp header to indicate when the command
output was generated. This information can be helpful when communicating with Support.
For more information, see Timestamp in show command outputs on page 18.
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Chapter 3: Command Line Interface (CLI)

This chapter describes the Command Line Interface (CLI). CLI is an industry standard command
line interface that you can use for single-device management.

Command Line Interface Fundamentals
The following sections contain conceptual information about the Command Line Interface (CLI).

CLI Command Modes
Command Line Interface (CLI) command modes provide specific sets of CLI commands. When you
log onto the switch, you are in User EXEC mode with limited commands. While in a higher mode,
you can access most commands from lower modes, except if they conflict with commands of your
current mode.

There are two categories of CLI commands: show commands and configuration commands. Show
commands can be used from multiple command modes with the same results; they show the same
configuration information regardless of the command mode from which the show command is used.
Configuration command results, however, may be dependent on the command mode from which a
configuration command is used. For example, an enable command used in Global Configuration
mode will enable a feature globally for all devices, while the same command used from one of the
interface command modes will enable a feature for a specific interface only.

Your user authorization credentials determine what commands are available to you in Privileged
EXEC mode and all higher level modes. If you have read-only access, you cannot progress beyond
User EXEC mode. If you have read-write access, you can progress through all available modes.

The CLI commands for navigating from lower to higher level modes are listed in the following table.
To navigate from higher to lower level modes, use the following commands:

• exit to navigate from a higher level mode to a lower level mode, down to Privileged EXEC
mode

• end from any command mode directly to Privileged EXEC mode

• disable to navigate from Privileged EXEC mode to User EXEC mode

• logout to terminate the CLI session from any command mode

June 2019 Using CLI and EDM on ERS 4900 and 5900 Series 11



The following table describes the various command modes, including the CLI commands to access
and to exit each mode.

Table 3: CLI command modes

Command mode and sample
prompt

Command to access mode Command to exit mode

User EXEC

Switch>
No entrance command, default
mode

exit
or

logout
Privileged EXEC

Switch#
enable exit

or

logout
Global Configuration

Switch(config)#
configure terminal To return to Privileged EXEC

mode, enter

end
or

exit
To exit CLI completely, enter

logout
Interface Configuration

Switch(config-if)#
You can configure the following
interfaces:

• Ethernet

• Loopback

• Management

• VLAN

From Global Configuration mode:

To configure a port, enter
interface ethernet <port
number>.

To configure a loopback, enter
interface loopback
<loopback number>.

To configure a management, enter
interface mgmt <mgmt
number>
To configure a VLAN, enter
interface vlan <vlan
number>.

To return to Global Configuration
mode, enter

Exit
To return to Privileged EXEC
mode, enter

end
To exit CLI completely, enter

logout

Router Configuration

Switch(configrouter)#
You can configure the following
routers:

• RIP
• OSPF
• VRRP

From Global or Interface
Configuration mode:

To configure RIP, enter router
rip.

To configure OSPF, enter router
ospf.

To return to Global Configuration
mode, enter

exit.

To return to Privileged EXEC
mode, enter

end.

Table continues…

Command Line Interface (CLI)
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Command mode and sample
prompt

Command to access mode Command to exit mode

• ISIS To configure VRRP, enter router
vrrp.

To configure IS-IS, enter router
isis.

To exit CLI completely, enter

logout.

Application Configuration

Switch(config-app)
From Global, Interface or Router
Configuration mode, enter
application.

To return to Global Configuration
mode, enter

exit.

To return to Privileged EXEC
mode, enter

end.

To exit CLI completely, enter

logout.

DHCP Guard Configuration

Switch(config-dhcpguard)
From Global, Interface, Router,
Application Configuration mode,
enter ipv6 dhcp guard
policy <policy_name>.

To return to Global Configuration
mode, enter

exit.

To return to Privileged EXEC
mode, enter

end.

To exit CLI completely, enter

logout.

RA Guard Configuration

Switch(config-raguard)#
From Global, Interface, Router,
Application Configuration mode,
enter ipv6 nd raguard
policy <policy_name>.

To return to Global Configuration
mode, enter

exit.

To return to Privileged EXEC
mode, enter

end.

To exit CLI completely, enter

logout.

Command completion
The CLI provides potential command completions to the command string. Completions are provided
by using a question mark (?) or by using the CLI autocompletion feature.

Command Line Interface Fundamentals
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? command completion
The ? command completion is available for any valid command. By typing a command and using
a ? as the last argument in the command, the system returns a list of possible command
completions from the point of the ?. A short description is provided with each possible completion.

Example
If you enter the following command:
Switch:1(config-ospf)#redistribute ?

CLI provides a list of completions for the redistribute ? command.
Switch:1(config-ospf)#redistribute ?
    direct     Configure OSPF redistribution policies for direct routes 
       isis       Configure OSPF redistribution policies for isis routes
       rip        Configure OSPF redistribution policies for RIP routes
    static     Configure OSPF redistribution policies for static routes

All the parameters listed under redistribute indicate sub-context commands.
You must use one of the available completions, and if necessary, use the command completion help
again to find the next completion.
Switch:1(config-ospf)#redistribute direct ?
  enable       Enable isis redistribute direct command
<cr>

When you see <cr> (Carriage Return/Enter Key) in the list with the additional choices, this means
that no additional parameters are required to execute the CLI command. However, the additional
choices listed could be peer commands or sub-context commands.
For example, the parameter listed under redistribute direct ? is a peer commands. You can
enter these peer commands on the same line as the root command, for example redistribute
direct enable. However, the <cr> indicates that you can also enter the redistribute
direct command only and this command does not require any additional parameters at this level.

CLI autocompletion
CLI autocompletion is a feature that you can use to automatically fill in the unique parts of a
command string rather than typing the entire command. Autcompletion makes the CLI experience
easier and prevents mistakes in spelling that force you to re-enter the command.
Autocompletion completes the token in the command as soon as it becomes unique.
The Tab key autocompletes the command without executing the command, and places the cursor
immediately after the last character. The Enter key autocompletes the command and executes it.

Example
To enable redistribution of OSPF direct routes,
Switch:1(config-ospf)#redistribute direct

When you use redistribute ?, you see four possible sub-context commands.
direct
          isis
          rip
          static

Command Line Interface (CLI)
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If you type the following without pressing Enter:
Switch:1(config-ospf)#redistribute direct m

and press the Tab key, the system completes the command to the following point:
redistribute direct metric

Two possible completions exist. You can type -t, and then press Tab to finish the command:
Switch:1(config-ospf)#redistribute direct metric-type

default command operator
You can reset the modified configuration of a command to the default configuration by using the
default operator.

Use the ? command completion along with the default keyword in each configuration mode, to view
the list of commands that support the default operator. For more information, see Command
completion on page 13.

Example
Configure csnp-interval to its default value. The default value of csnp-interval is 10
seconds.
Switch:1>enable
Switch:1#configure terminal
Enter configuration commands, one per line.  End with CNTL/Z.
Switch:1(config)#router isis
Switch:1(config-isis)#show isis

========================================================================================
                               ISIS General Info
========================================================================================
                            AdminState : disabled
                            RouterType : Level 1
                             System ID : e45d.523c.6484
                  Max LSP Gen Interval : 900
                                Metric : wide
                   Overload-on-startup : 20
                              Overload : false
                         Csnp Interval : 200
                         PSNP Interval : 2
                     Rxmt LSP Interval : 5
                             spf-delay : 100
                           Router Name :
                     ip source-address :
                   ipv6 source-address :
              ip tunnel source-address :
                            Tunnel vrf :
                         ip tunnel mtu :
                     Num of Interfaces : 1
                 Num of Area Addresses : 0

                        inband-mgmt-ip :
                              backbone : disabled
              Dynamically Learned Area : 00.0000.0000
                            FAN Member : Yes

Command Line Interface Fundamentals
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Switch:1(config-isis)#default csnp-interval
Switch:1(config-isis)#show isis

========================================================================================
                               ISIS General Info
========================================================================================
                            AdminState : disabled
                            RouterType : Level 1
                             System ID : e45d.523c.6484
                  Max LSP Gen Interval : 900
                                Metric : wide
                   Overload-on-startup : 20
                              Overload : false
                         Csnp Interval : 10
                         PSNP Interval : 2
                     Rxmt LSP Interval : 5
                             spf-delay : 100
                           Router Name :
                     ip source-address :
                   ipv6 source-address :
              ip tunnel source-address :
                            Tunnel vrf :
                         ip tunnel mtu :
                     Num of Interfaces : 1
                 Num of Area Addresses : 0

                        inband-mgmt-ip :
                              backbone : disabled
              Dynamically Learned Area : 00.0000.0000
                            FAN Member : Yes

Example
View the IP configuration commands for a VLAN interface that support the default operator.
Switch:1>enable
Switch:1#configure terminal
Enter configuration commands, one per line.  End with CNTL/Z.
Switch:1(config)#interface vlan 1
Switch:1(config-if)#default ?
Default settings
ip                 Restore default L3 parameters on a VLAN
ipv6               Restore default IPv6 parameters on a VLAN

Switch:1(config-if)#default ip ?
Restore default L3 parameters on a vlan
  arp-proxy           Restore default Proxy ARP
  dhcp-relay          Disable DHCP relay on this vlan
  directed-broadcast  Restore default IP directed-broadcast
  forward-protocol    Configure to default broadcast forwarding
  fwd-nh              Restore default IP forwarding next-hop config settings
  igmp                Restore default per-vlan IGMP settings
  ipsec               ipsec configuration for an interface
  ospf                Restore default OSPF settings
  pim                 Restore default per-vlan PIM settings
  rip                 Restore default RIP settings
  routing             Disable L3 routing on a VLAN
  spb-multicast       Default spb-multicast commands
  vrrp                Restore default VR settings
Switch:1(config-ip)#default ip igmp ?
  <cr>

Command Line Interface (CLI)
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no command operator
You can use the no operator in a command to negate a configuration. Based on the functionality of
the command, you can perform negations, such as disable, delete, remove, or reset to the default
configuration.

Use the ? command completion along with the no keyword to view the list of commands that support
the no operator in each configuration mode. For more information, see Command completion on
page 13.

Example
Negate the automatic virtual link that provides automatic dynamic backup link for OSPF traffic.
Switch:1>enable
Switch:1#configure terminal
Enter configuration commands, one per line.  End with CNTL/Z.
Switch:1(config)#router ospf
Switch:1(config-router)#no auto-vlink

Example
Remove an IP address configuration from VLAN.
Switch:1>enable
Switch:1#configure terminal
Enter configuration commands, one per line.  End with CNTL/Z.
Switch:1(config)#interface vlan 3
Switch:1(config-if)#no ip address 192.0.2.4

Example
View the commands that can negate a configuration in RIP router configuration mode.
Switch:1>enable
Switch:1#configure terminal
Enter configuration commands, one per line.  End with CNTL/Z.
Switch:1(config)#router rip
Switch:1(config-rip)#no ?
Negate a command or set its defaults
ipv6          Disable ipv6 configurations
network       Disable rip on an ip network
redistribute  To disable/delete redistribute golbally
Switch:1(config-rip)#no network ?
  {A.B.C.D}  Network ip address
LabSwitch:1(config-rip)#no network 192.0.2.4 ?
  <cr>

GREP with CLI show command
You can use Global Regular Expression Print (GREP) with show commands to filter the output
based on match criterial.

Enter the show command followed by the pipe (|) character, followed by the GREP filter command.
The show command output contains only the lines that match the GREP filter pattern.

Command Line Interface Fundamentals
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The following GREP filter commands are supported:

Filter function Description
count Counts the number of lines in the output of a command.
match Displays only the output lines which match the given pattern.
except Displays only the output lines which do not match the given pattern.
find Displays the output of a command starting from the first line which matches

the given pattern.
no-more Temporarily disables pagination for the output of an CLI command. When

the lines of output exceed the terminal length, the entire output of the
command is displayed and message does not appear to continue or quit.

head Limits the output of a command to the first few lines. If limit is not specified,
the first 10 lines appear.

tail Limits the output of a command to the last few lines. If a number is not
specified the last 10 lines are shown.

For more information about the functions, see GREP CLI show command filters on page 27.

Timestamp in show command outputs
The output for all CLI show commands includes a timestamp header to indicate when the command
output was generated. This information can be helpful when communicating with Support.

The following command output shows a timestamp example.
Switch#show stack-info

******************************************************************************
        Command Execution Time: 2019-05-15 12:30:52 GMT+00:00
******************************************************************************
Unit# Switch Model     Pluggable Pluggable Pluggable  Pluggable SW Version
                         Port      Port      Port       Port
----- ---------------- --------- --------- --------- ---------- ----------
1     5928GTS          (25) None (26) None (27) None  (28) None v7.7.0.079

CLI help
CLI help is available at all levels.

CLI list
From the User EXEC mode, the CLI list command show cli list displays a detailed view of the
CLI commands. Additionally, the verbose command, show cli list verbose lists the CLI
syntax for each command.

Command list
To obtain a list of all commands available from a prompt, enter a question mark (?).

Command Line Interface (CLI)
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Command options
To obtain a list of all options for a command, at the prompt enter a portion of a command followed by
a space and a question mark (?).

Command names
To obtain a correct command name, at the prompt enter a portion of the command name, and then
press the Tab key. The system displays the first unambiguous match for your selection. For
example, when you enter down + Tab, the system displays download.

Command modes
To obtain a list of CLI command modes available, enter help modes.

Commands organized by mode
To obtain a list of CLI commands, organized by command mode, enter help commands. A short
explanation of each command is included.

Keystroke shortcuts
To make using CLI easier, use the keystroke shortcuts in the following table.

Key combination Function
Ctrl+A Start of line
Ctrl+B Back 1 character
Ctrl+C Abort command
Ctrl+D Delete the character indicated by the cursor
Ctrl+E End of line
Ctrl+F Forward 1 character
Ctrl+H Delete character left of cursor (Backspace key)
Tab Command or parameter completion
Ctrl+K and Ctrl+R Redisplay line
Ctrl+N or Down arrow Next history command
Ctrl+P or Up arrow Previous history command
Ctrl+T Transpose characters
Ctrl+U Delete entire line
Ctrl+W Delete word to left of cursor
Ctrl+X Delete all characters to left of cursor
Ctrl+z Exit Global Configuration mode to Privileged EXEC mode
? Context sensitive help
Esc+C and Exc+U Capitalize character at cursor
Esc+l Change character at cursor to lower case
Esc+B Move back 1 word
Esc+D Delete 1 word to the right
Esc+F Move 1 word forward

Command Line Interface Fundamentals
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Command Line Interface Procedures
The following sections contain information about common Command Line Interface (CLI) tasks. You
can access CLI during runtime to manage the switch.

CLI Access Procedures
Before you begin

• Connect to the switch with a console cable, connected directly to the console port, or use
Telnet.

• To connect to the switch remotely, through Telnet, ensure that you enable remote access, and
that the switch IP address is valid.

• Use a terminal, or computer with a terminal emulator, as the CLI command station.
• If you use a console cable and console port, ensure that the terminal emulation program

conforms to settings listed in the following table.

Property Value
Baud Rate 9600 bps
Data Bits 8
Stop Bits 1
Parity None
Flow Control None
Terminal Protocol VT100 and VT100/ANSI

Opening a CLI session
Procedure

1. Connect to the switch.

2. Enter the password, if applicable.

3. At the CLI Banner Screen, enter CTRL+Y.

4. To access CLI, from the main menu, press c or scroll to Command Line Interface.

5. Press Enter.

Configuring the path to the help files using CLI
Use this procedure to configure the path to the help files.

Procedure
1. Enter Global Configuration mode:

enable
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configure terminal
2. At the command prompt, enter the following command:

edm help-file-path <path name> {tftp <address> {<A.B.C.D> | <IPv6-
Address>} | usb unit <1-8>}

Variable definitions
Use the definitions in the following table to use the edm help-file-path command.

Variable Definition
path name Specifies the path you created for EDM help files.

The path name is stored in NVRAM.
TFTP <A.B.C.D> Specifies the IPv4 address of the TFTP server.

Use this address only for EDM help files.

If you do not specify a TFTP server address, the
system uses the address specified most recently.

Important:

Because the TFTP server address is stored in
NVRAM, each time the system returns to the
default configuration, you must reconfigure the
path to EDM online help.

TFTP <IPv6-address> Specifies the IPv6 address of the TFTP server.

Use this address only for EDM help files.

If you do not specify a TFTP server address, the
system uses the address specified most recently.

Important:

Because the TFTP server address is stored in
NVRAM, each time the system returns to the
default configuration, you must reconfigure the
path to EDM online help.

usb <unit> Specifies the unit number where the USB mass
storage device that contains the help files resides.
The unit number is an integer from 1 through 8.

CLI configuration files
Configuration files are ASCII text files that allow an administrator to change switch configuration
quickly.

Use the procedures in the following sections to display, store, and retrieve configuration files, and
also to save the current configuration using the CLI.
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Procedures to manage binary configuration files are included in the Enterprise Device Manager
section.

Viewing current configuration using CLI
Use this procedure to view the current configuration.

Procedure
1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

show running-config

Saving current configuration to TFTP server using CLI
Procedure

1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

copy running-config tftp [address (<A.B.C.D> | <WORD>)] [filename
<WORD>]

Variable definitions
The following table describes the parameters for the copy running-config command.

Variable Value
address<A.B.C.D> Specifies the address of the TFTP server.

• A.B.C.D — specifies the IP address
filename<name> Specifies the configuration file name.

Variable definitions
The following table describes the parameters for the copy running-config sftp command.

Variable Value
address<A.B.C.D> Specifies the address of the TFTP server.

• A.B.C.D — specifies the IP address
filename<name> Specifies the configuration file name.
module Copies configuration of an application.
verbose Copies entire configuration (defaults and non-

defaults).
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Saving current configuration to SFTP server using CLI
Procedure

1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

copy running-config sftp [verbose] [module<applicationModules>]
[filename <WORD>] ([address {<A.B.C.D> | <ipv6addr>}]) username
<WORD> [password]

Saving current configuration to USB device using CLI
Procedure

1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

copy running-config usb [filename <WORD>] [module
<applicationModules>] [verbose]

Saving current configuration to flash memory using CLI
Use this procedure to save the current configuration to flash memory. Note that the system
automatically issues the copy config nvram command periodically.

Procedure
1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

copy config nvram

Note:

The current configuration can also be saved to Non-Volatile RAM (NVRAM) using the
write memory command or the save config command. Both of these commands
are also issued from Privileged EXEC command mode.

Restoring system configuration from TFTP using CLI
Use this procedure to restore the system configuration from TFTP.

Procedure
1. Enter Privileged EXEC mode:

enable
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2. At the command prompt, enter the following command:

copy tftp config address <A.B.C.D> filename <name>
Variable definitions

The following table describes the parameters for the copy tftp config command.

Variable Value
address <A.B.C.D> Specifies the address of the TFTP server.

• A.B.C.D — specifies the IP address
filename <name> Specifies the configuration file name.

Restoring system configuration from SFTP using CLI
Procedure

1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

copy sftp config address <A.B.C.D> | <WORD> filename <name> username
<WORD> [password]

Restoring system configuration from USB device using CLI
Procedure

1. Enter Privileged EXEC mode:

enable
2. At the command prompt, enter the following command:

copy config usb {filename <name> | unit <1–8>}

Copying stack unit configuration to standalone switch using CLI
Procedure

1. Enter Privileged EXEC mode:

enable
2. At the prompt, enter copy [ tftp | sftp ] config address <A.B.D.C> |

<WORD> filename <name> unit <unit number> .

Downloading a configuration file automatically using CLI
Use this procedure to configure a switch to automatically load a configuration file.

Procedure
1. Enter Privileged EXEC mode:
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enable
2. At the command prompt, enter the following command:

configure network load-on-boot {disable | use-bootp | use-config}
address <A.B.C.D> filename <name>

Variable definitions
The following table describes the parameters for the copy running-config command.

Variable Value
address <A.B.C.D> Specifies the address of the TFTP server.

• A.B.C.D — specifies the IP address
filename <name> Specifies the configuration file name.
username <WORD> Specifies the username for downloading a configuration file

automatically using CLI.
[password] Specifies the password for downloading a configuration file

automatically using CLI.

Use the definitions in the following table to use the configure network load-on-boot command.

Variable Value
load-on-boot {disable | use-bootp | use-
config}

Specifies the setting to automatically load a configuration file
when the system starts

• disable — disables the automatic loading of the configuration
file

• use-bootp — specifies loading the ASCII configuration file at
startup and using BootP to obtain values for the TFTP
address and file name

• use-config — specifies loading the ASCII configuration file at
startup and using the locally configured values for the TFTP
address and file name

If you omit the variables, the system immediately downloads
and runs the ASCII configuration file.

Viewing USB files
Use this procedure to display configuration files stored on a USB device in a unit in a stack.

Before you begin
Insert a USB device in the base unit or in a stack unit.

Procedure
1. Enter Privileged EXEC mode:

enable
2. To display files on a USB device inserted in the base unit, enter the following command :
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show usb-files
3. To display files on a USB device inserted in a stack unit, enter the following command :

show usb-files unit <unit_number>

Displaying USB file information using CLI
Before you begin
Insert USB device in the switch.

Procedure
1. Enter Privileged EXEC mode:

enable
2. Enter the following command:

show usb-host-port all
Example

Downloading an ASCII configuration file from a TFTP server or USB device
Use this procedure to download an ASCII configuration file from a TFTP server or USB device to the
local ASCII file system. You can then boot the system from the local file system. In a stack, the
downloaded ASCII configuration file will be saved in all units.

Procedure
1. Enter Global Configuration mode:

enable
configure terminal

2. To download from a TFTP server, enter the following command at the command prompt:

3. To download from a USB device, enter the following command at the command prompt:

Next steps
Proceed with theboot script command to boot the system with the local ASCII configuration file.

When the system boots successfully with an ASCII configuration file, the system configuration is
saved to the binary configuration. If the system boot fails, the system resets and boots with the
current binary configuration.

Variable definitions
The following table describes the parameters for the copy [tftp] [usb] script command.
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Variable Value
address <A.B.C.D> Specifies the address of the TFTP server.

• A.B.C.D — specifies the IPv4 address

• WORD - specifies the IPv6 address
filename <Word> Specifies the name of the file to be retrieved.
block <1–2> [name <WORD>] Specifies the block from which the ASCII configuration file is to

be downloaded

If you do not specify a name for the block name, the default is
the name of the file retrieved.

GREP CLI show command filters
Use the following GREP filter procedures to output only the command lines specified by the filter.

Count filter
This filter counts the number of lines in the output of a command.

Syntax
<CLI command> | count
Example
#show running-config | count
Count: 100 lines

Display output matching a pattern
The match filter displays only the output lines that match the given pattern.

Syntax
<CLI command> | match <pattern> [field <number>] [ignore-case] [header
<number>]
Parameter Description
pattern Specifies the regular expression to be matched against each line of

output. Quotations are required if the parameter contains spaces.
field <number> Specifies the field in each line to be matched against the pattern. Fields

are separated by white spaces and are counted starting with 1 for the
left-most field.

ignore-case Specifies letters to be matched in the pattern regardless of case.
header <number> Specifies a number of lines from the start of the output to be displayed

unchanged before trying to match the pattern. Useful to keep the
header of a table intact.
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Examples
#show interfaces | match 1000 header 3
              Status                    Auto                        Flow  
Port Trunk Admin   Oper Link LinkTrap Negotiation  Speed   Duplex Control
---- ----- ------- ---- ---- -------- ----------- -------- ------ -------
5          Enable  Up   Up   Disabled Enabled     1000Mbps Full   Asymm  
9          Enable  Up   Up   Enabled  Enabled     1000Mbps Full   Asymm
#show interfaces | match disabled field 5 ignore-case
5          Enable  Up   Up   Disabled Enabled     1000Mbps Full   Asymm   
11         Enable  Down Down Disabled Enabled

Ignore output that matches a pattern
The ignore filter displays only the output lines that do not match the given pattern. The lines
matching the pattern are discarded.

Syntax
<CLI command> | except <pattern> [field <number>] [ignore-case] [header
<number>]
Parameter Description
pattern Specifies the regular expression to be matched against each line of

output. Quotations are required if the parameter contains spaces.
field <number> Specifies the field in each line to be matched against the pattern. Fields

are separated by white spaces and are counted starting with 1 for the
left-most field.

ignore-case Specifies letters to be matched in the pattern regardless of case.
header <number> Specifies a number of lines from the start of the output to be displayed

unchanged before trying to match the pattern. Useful to keep the
header of a table intact.

Example
#show interfaces | except down ignore-case header 3 
              Status                    Auto                        Flow  
Port Trunk Admin   Oper Link LinkTrap Negotiation  Speed   Duplex Control
---- ----- ------- ---- ---- -------- ----------- -------- ------ -------
5          Enable  Up   Up   Disabled Enabled     1000Mbps Full   Asymm   
9          Enable  Up   Up   Enabled  Enabled     1000Mbps Full   Asymm

Display output from the first match of a pattern
The find filter displays the output of a command starting from the first line that matches the given
pattern.

Syntax
<CLI command> | find <pattern> [field <number>] [ignore-case] [header
<number>]
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Parameter Description
pattern Specifies the regular expression to be matched against each line of

output. Quotations are required if the parameter contains spaces.
field <number> Specifies the field in each line to be matched against the pattern. Fields

are separated by white spaces and are counted starting with 1 for the
left-most field.

ignore-case Specifies letters to be matched in the pattern regardless of case.
header <number> Specifies a number of lines from the start of the output to be displayed

unchanged before trying to match the pattern. Useful to keep the
header of a table intact.

Example
#show interfaces | find 47 header 3
              Status                    Auto                        Flow  
Port Trunk Admin   Oper Link LinkTrap Negotiation  Speed   Duplex Control
---- ----- ------- ---- ---- -------- ----------- -------- ------ -------
47         Enable  Down Down Enabled  Enabled                             
48         Enable  Down Down Enabled  Enabled                             
49         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm   
50         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm   
51         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm   
52         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm

Do not paginate output of a single command
The no-more command filter temporarily disables pagination for the output of an CLI command.
When the lines of output exceed the terminal length, you are not prompted to continue or to quit but
the entire output of the command continues to be displayed. The effect is similar to setting terminal
length 0 but only for the current command.

Example
#show interfaces | no-more

Display only the first few lines of output
The head filter limits the output of a command to the first few lines. If a number is not specified then
the first 10 lines are shown.

Syntax
<CLI command> | head [<number>]
Parameter Description
<number> Specifies the number of lines to keep from the beginning of the output.

Example
#show interfaces | head
              Status                    Auto                        Flow  
Port Trunk Admin   Oper Link LinkTrap Negotiation  Speed   Duplex Control
---- ----- ------- ---- ---- -------- ----------- -------- ------ -------
1          Enable  Down Down Enabled  Enabled                             
2          Enable  Down Down Enabled  Enabled                             
3          Enable  Down Down Enabled  Enabled
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4          Enable  Down Down Enabled  Enabled   
5          Enable  Up   Up   Disabled Enabled     1000Mbps Full   Asymm
6          Enable  Down Down Enabled  Enabled
7          Enable  Down Down Enabled  Enabled

Display only the last few lines of output
The tail filter limits the output of a command to the last few lines. If a number is not specified, then
the last 10 lines are shown.

Syntax
<CLI command> | tail {[<number>] | from-line <number> } [header <number>]
Parameter Description
<number> Specifies the number of lines to keep from the end of the output.
from-line <number> Specifies the line from which to start the output.
[header] Same description as for the other commands which allow it.

Example
#show interfaces | tail 3
50         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm   
51         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm     
52         Enable  Down Down Enabled  Disabled    10Gbps   Full   Asymm

Regular expressions
Match, except, and find filters require a pattern parameter, which is a regular expression.

Pattern parameter Description
regular expression Zero or more branches separated by the pipe symbol ‘|’ It matches anything

that matches one of the branches.
branch Zero or more pieces, concatenated. For instance, it matches a match for the

first, followed by a match for the second.
piece An atom possibly followed by `*', `+', or `?'. An atom followed by `*' matches a

sequence of 0 or more matches of the atom. An atom followed by `+' matches
a sequence of 1 or more matches of the atom. An atom followed by `?'
matches a match of the atom, or the null string.

atom A regular expression in parentheses (matching a match for the regular
expression), a range, `.' (matching any single character), `^' (matching the null
string at the beginning of the input string), `$' (matching the null string at the
end of the input string), a `\' followed by a single character (matching that
character), or a single character with no other significance (matching that
character).

range A sequence of characters enclosed in `[ ]'. It normally matches any single
character from the sequence. If the sequence begins with `^', it matches any
single character not from the rest of the sequence. If two characters in the
sequence are separated by `-', this is shorthand for the full list of ASCII
characters between them (for example, `[0-9]' matches any decimal digit). To

Table continues…
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Pattern parameter Description
include a literal `]' in the sequence, make it the first character (following a
possible `^'). To include a literal `-', make it the first or last character.
If the pattern includes white spaces then it must be enclosed in quotation
marks.
To match characters which have a special meaning – one of *.+?^$()[]\ – they
must be escaped. They must be preceded by a single backslash if the pattern
is not in quotation marks and by double backslash if the pattern is enclosed in
quotes.

Regular expression examples
Regular expression Description
est Matches a string containing “est”. For example, “testing”.
A(d+)r Matches a string containing an ‘A’ followed by at least one ‘d’ followed by ‘r’.

For example, “Address”.
^1 Matches a ‘1’ only at the beginning of a line.
192\.[0-9]+\.[0-9]+\.[0-9]+ Matches a string representing a valid IPv4 address starting with 192.
“192\\.[0-9]+\\.[0-9]+\\.
[0-9]+”

Matches a string representing a valid IPv4 address starting with 192 when the
pattern is enclosed in quotes.

The un-escaped ‘.’ means “any single character” which would make the
regular expression accept invalid addresses as well.

Enabling the Web server using CLI
The Web server is enabled by default. If you have assigned an IP address to the switch you can
access EDM.

If you have disabled the Web server, use this procedure to enable and manage the Web server
using CLI. After you enable the Web server you can start EDM.

Procedure
1. Enter Global Configuration mode:

enable
configure terminal

2. At the command prompt, enter the following command:

web-server enable
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Disabling the Web server using CLI
Use this procedure to disable the Web server using CLI. After you disable the Web server, you
cannot start EDM.

Procedure
1. Enter Global Configuration mode:

enable
configure terminal

2. At the command prompt, enter the following commands:

no web-server
web-server disable

Displaying the Web server status using CLI
Use the following procedure to display the status of the Web server using CLI.

Procedure
1. Enter Global Configuration mode:

enable
configure terminal

2. At the command prompt, enter the following command:

show web-server
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Chapter 4: Enterprise Device Manager
(EDM)

This chapter describes the Enterprise Device Manager (EDM).
Related links

Enterprise Device Manager concepts on page 33
Interface components on page 35
Enterprise Device Manager procedures on page 48
Enterprise Device Manager configuration files on page 55

Enterprise Device Manager concepts
To manage the switch from a centralized location Extreme Networks offers optional, product-specific
EDM plug-ins for Configuration and Orchestration Manager (COM) that include other features, such
as centralized syslog, trap viewer, troubleshooting and diagnostic tools. For more information, or to
purchase plug-ins, go to https://extremeportal.force.com.

The following table compares EDM functions in the embedded version to COM plug-in version.

Table 4: EDM functions: embedded version compared to COM plug-in version

EDM functions Embedded version Plug-in version
100% device configuration: device
view, device-specific configuration

Yes, with COM 2.0 and higher Yes, with COM 2.0 and higher

Stackable Device Web User
Interface features

Yes No

Centralized off-box multi-user
element management:

• user and device credential
manager

• user preference

• SSO–based user access control

No Yes

Table continues…
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EDM functions Embedded version Plug-in version
• user-based Device Access

Control (read only and read-
write)

• authentication through third
party (RADIUS, Microsoft AD,
Sun AM)

Centralized EDM plug-in
management (downloadable
install and uninstall, upgrade,
patch, and inventory view)

No Yes

User activity log and audit trail No Yes
Device performance monitoring
and polling

Limited High performance and low latency

Device-specific single device
wizards and template

No Yes

Centralized syslog and trap viewer No Yes
Troubleshooting and diagnostic
tools (ping, CLI Manager, path-
trace)

No Yes

EDM is an embedded application that you can use for single device element management and
configuration through a standard Web browser. Because EDM is embedded into Ethernet Routing
Switch software, and the switch operates as a Web server, you do not require additional client
software.

Tested browsers
EDM has been tested with the following web browsers:

• Microsoft Internet Explorer 11.0
• Mozilla Firefox 45.0.2

Related links
Enterprise Device Manager (EDM) on page 33

Memory requirements
If you install Configuration and Orchestration Manager on a PC to manage your switch, the PC must
have at least 500 MB of free disk space.

There are no memory requirements to use EDM through a Web browser.
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Related links
Enterprise Device Manager (EDM) on page 33

Online help
Online help is context-sensitive and appears in a separate window in the Web browser.

To obtain help for the current topic, click the help button on the toolbar in the work area.

If you are not using EDM through COM, you need to download the help file to a TFTP server and
configure the EDM Help file path. For more information, see Configuring the path to the help files
using CLI on page 20.

Related links
Enterprise Device Manager (EDM) on page 33
Enterprise Device Manager (EDM) on page 33

Interface components
This section describes Enterprise Device Manager interface components.

The Enterprise Device Manager window includes the following parts:

• Navigation tree toolbar

• Switch Summary View

• Device Physical View

• EDM window

• Navigation tree

• Menu bar

• Tool bar

• Work area

Switch summary view
The EDM initial view displays a switch summary view in the work area.

The Switch Summary tab displays basic switch information. This information-only display derives
from the configuration tab Edit, Chassis, Chassis.

Online help
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Following is a list of the fields on the Switch Summary tab:

• hardware model

• hardware version

• firmware version

• software version

• system uptime

• system object identifier

• system contact

• system name

• system location

A Stack Information panel appears at the bottom of the switch summary view work area that
provides a description of your switch or the units in your switch stack.

This information includes the following:

• Unit number (for stacks) – also lists which unit is the base unit in a stack

• Switch type

• Description

• Running software version

Device Physical View
When you access EDM, the first panel in the work area displays a switch summary view. The tab
behind the summary view is a real-time physical view of the front panel of a device or stack called
the Device Physical View.

Objects in the Device Physical View are

• a stand-alone switch, called a unit

• a switch stack, called a chassis

• a port

From the Device Physical View you can

• determine the hardware operating status

• select a switch or a port to perform management tasks on specific objects or view fault,
configuration, and performance information for specific objects

To select an object, click the object. The system outlines the object in yellow, indicating that the
object selected.
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The conventions on the device view are similar to the actual switch appearance except that LEDs in
Device Physical View do not blink. The LEDs and the ports are color-coded to reflect hardware
status. Green indicates the port is up and running; red indicates that the port is disabled.

From the menu bar you can click the Device Physical View tab to open the Device Physical View
any time during a session.

Figure 1: Device Physical View

Note:

Depending on your hardware model, your switch might appear different than the figure shown in
this section.

EDM window
The EDM window contains the following parts:

1. navigation tree—the navigation pane on the left side of the window that displays available
command folders in a tree format

2. menu bar—the area at the top of the window that displays primary and secondary tabs that
you accessed during the session; the tabs remain available until you close them

3. toolbar—the area just below the menu bar that provides quick access to the most common
operational commands such as Apply, Refresh, and Help

4. work area—the main area on the right side of the window that displays the dialog boxes
where you view or configure switch parameters

Note:

Depending on your hardware model, information displayed may appear different than the figure
shown in this section.

Interface components

June 2019 Using CLI and EDM on ERS 4900 and 5900 Series 37



Figure 2: EDM window

Navigation tree
The navigation tree displays available command topics as folders in a tree, as described in the table
below.

Table 5: Folders and subfolders in the navigation tree

Folder Description
Administration Use the selections in the Administration folder to perform the following

functions:

• Quick Start — sets up IP/Community/VLAN

• Remote Access — enables or disables Telnet, SNMP, Web Page,
and SSH

• Run Script — configures parameters for the switch

• MIB Web Page — performs a MIB Walk
Device Rediscover Device — Use the Rediscover Device selection to refresh

the session.

Caution:

All existing tabs are lost.
Edit Opens edit dialog boxes for the objects selected in the navigation tree.

Use the selections in the Edit folder to view or change parameters for
the currently-selected object.

• Unit

• Chassis: Chassis, Switch/Stack, Ports, and Environment

• Bridge

• File System
Table continues…
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Folder Description
• ADAC

• Diagnostics: Port Mirrors, Topology, System Log. 802.1AB: LLDP,
Port MED, Vendor Specific

• SNTP/Clock

• Fabric Attach

• Snmp Server: MIB View, User, Community, Host, Notification Control

• Storm Control
Security Use the selections in the Security folder to view or change security

settings.

• General

• MAC Security

• DHCP Snooping

• Dynamic ARP Inspection (DAI)

• IP Source Guard (IPSG)

• 802.1X/EAP

• Web/Telnet/Console

• SSH/SSL

• RADIUS

• TACACS+
Graph Use the selections in the Graph folder to view statistics and produce

graphs of the statistics on the following tabs:

• Chassis

• Port — to view or graph statistics for a port, first select a port on the
Device Physical View.

Power Management The Power Management tab is available only for switches equipped
with Power over Ethernet (PoE). Use the tabs associated with the
subfolders in the Power Management folder to view and configure
Power over Ethernet (PoE) settings and to view and configure Energy
Saver settings.

Subfolders in the Power Management folder are:

• PoE

• Energy Saver
VLAN Use the selections in the VLAN folder to configure or view information

about the following:

• VLANs

• Spanning Tree: Globals, STG, RSTP, MSTP
Table continues…
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Folder Description
• MLT/LACP

• SLPP
IP Use the selections in the IP folder to set up IP functions on tabs in the

following sub-folders:

• IP

• TCP/UDP

• RIP

• IGMP

• DHCP Relay

• DHCP Server

• UDP Forwarding

• Policy
IPv6 Use the selections in the IPv6 folder to set up IPv6 routing functions on

tabs in the following sub-folders:

• IPv6

• TCP/UDP
QoS Use the selections in the QoS folder to configure quality of service and

set up QoS policies and filters using tabs in the following sub-folders:

• QoS Devices

• QoS Rules

• QoS

• QoS Agent

• QoS UBP/Traffic Profile
Serviceability Use the selections in the Serviceability folder to navigate to the

following sub-folders:

• RMon for remote monitoring and configuration of

- Alarms

- Control

• SLA Mon for Service Level Agreement monitoring
Help Use the tabs associated with the subfolders in the Help folder to access

help and support for the following:

• Device Manager Basic

• Extreme Portal

• Legend: Up, Down, No Link, Standby, Testing, Unmanageable, and
Loopback.
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To open a folder or sub-folder, you can click the arrowhead to the left of the folder or double-click the
folder to display the available commands tabs.

To close a folder, click the arrowhead once.

To access a command tab, double-click the selection in the navigation tree.

Navigation tree toolbar
You can use the toolbar above the navigation tree to perform common functions more easily.

Toolbar:

Figure 3: Toolbar

Following is a description of the toolbar button functions:

Button Description
Switch Summary – you can use the Switch Summary toolbar button to open or reopen
the switch summary tab
Refresh Status – in addition to the existing refresh methods you can use the Refresh
Status toolbar button to refresh the device status
Edit Selected – in addition to the existing edit methods, and depending on which
object you select on the Device Physical View, you can use this toolbar button to open
Edit > Chassis, Edit > Unit, or Edit > Ports tabs. If you do not select an object from the
Device Physical View and you click the Edit Select toolbar button, the Edit > Chassis
tab opens.
Graph Selected – depending on which object you select on the Device Physical View,
you can use this toolbar button to open Graph > Chassis or Graph > Port tabs. If you
do not make a selection on the Device Physical View, or if you select Unit, the Graph
> Chassis tab opens.
Save Config — this button allows you to save the current configuration. A window
appears asking if you want to save the configuration: click OK to save the
configuration or click Cancel to cancel the Save operation.
Help Setup Guide – this button connects you to the help setup guide for embedded
EDM and it replaces the link that appeared on the top right of work panes.

Under the toolbar is the Search function window. You can use the Search function window to find a
specific sub-folder or selection in the navigation tree.

Figure 4: Search function window

Enter the sub-folder or selection you are looking in the Search window and click the magnifying
glass to perform the search. The navigation tree displays the sub-folder that best matches your
search criteria.
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Menu bar
The menu bar appears above the work area and consists of two rows of tabs.

The top row displays tabs that were accessed from the navigation tree during the active session.
The tabs in this row, called primary tabs, are docked and available to reopen on demand. The
docked tabs appear in the sequence that you accessed them.

When you click a primary tab from the menu bar, the associated secondary tabs appear in the
second row and the default dialog box appears in the work area. Click any secondary tab to display
its associated dialog box.

Figure 5: Menu bar

If you want to open a dialog without displacing the current open dialog, you can go to the tab on the
menu bar and undock the tab by using your mouse to drag and drop it into the work area. You can
drag the dialog box to any location on the screen and you can toggle between the open dialog
boxes to compare information and make changes. When you no longer need the undocked tab, you
can use the three buttons on the upper right side of the tab to temporarily shrink it, re-dock it, or
close it.

In both rows of the menu bar, arrows can appear on the left and right sides when the number of
open tabs exceeds the available space. You can use the arrows to scroll to a tab, or you can select
the tab from the navigation tree.

To reduce the number of open tabs, you can click the X button on the top right of a tab to close it.

Tool bar
The tool bar, located below the menu bar, contains buttons that provide quick access to commonly
used operational commands. Depending on the tab selected, different buttons can appear.

Figure 6: Tool Bar

The following table describes common tool bar buttons.
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Table 6: Common tool bar buttons

Button Name Description
Apply Executes parameter changes

Refresh Refreshes screen data

Help Displays context-sensitive online help for the current
dialog box

Insert Opens an insert dialog box

Submits the entry from the insert dialog box

The insert buttons appear only on panes where you can
insert entries.

Delete Removes a selected entry

Cancel Cancels an operation

Work area
The work area, on the right side of the EDM page, displays the switch Device Physical View and
dialog boxes related to the menu selections in the navigation tree. You can use the work area to
view and configure switch parameters from the dialog boxes that appear in the work area.

See the following figure for an example of the work area for the File System, Config/Image/Diag file
dialog.

Figure 7: EDM work area
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Note:

Depending on your hardware model, information displayed may appear different than the figure
shown in this section.

Single port configuration for EDM
Note:

Depending on your hardware model, information displayed may appear different than the figures
shown in this section.

You can apply configuration changes to single ports by using one of the following methods:

• From the Device Physical View, you can right-click a port and select Edit from the drop-down
menu, then click the appropriate tab.

The following figure displays the drop-down menu for the selected port in the Device Physical
View.

Figure 8: Device Physical View - port edit

The following figure displays the port edit work area with the VLAN tab selected.
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Figure 9: Port edit -VLAN tab

• From the Navigation tree you can select any tab from the Edit, Chassis, Ports work flow and
double-click a cell under an editable parameter column heading in the appropriate port row of
the table.

The following figure displays the Edit, Chassis, Ports work area with the Interface tab selected.

Figure 10: Edit, Chassis, Ports - Interface tab

• From the Navigation tree you can select a port-related tab from a specific, applicable feature
work area (for example, VLAN, VLANs, Ports), and double-click a cell under an editable
parameter column heading in the appropriate port row of the table.

The following figure displays the VLAN, VLANs, Ports tab work area.
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Figure 11: VLAN, VLANs - Ports tab

Multiple Port Configuration for EDM
Note:

Depending on your hardware model, information displayed may appear different than the figures
shown in this section.

When you need to apply the same configuration changes to more than one port, you can use the
Multiple Port Configuration function available on all tabs in the Edit, Chassis, Ports work flow, or on
port-related tabs for specific, applicable feature work areas (for example, VLAN, VLANs, Ports).

The following sections use the Edit, Chassis, Ports, Interface tab work area to describe the available
Multiple Port Configuration functions.

In the work area for any of the Edit, Chassis, Ports tabs, the following two panes appear in the
default view:

• Multiple Port Configuration pane—provides port selection for one port, several ports, or all
ports, and configurable port parameters

• Tab work pane—displays existing configuration information for the feature and configurable
cells for individual ports

With Multiple Port Configuration you can perform the following:

• Hide non-editable fields from the multiple configuration pane so that you choose to view only
those fields that can be configured.

• Select an individual port or a group of ports from the Port Editor.
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• Select all ports from the Port Editor.

• Double-click any or all of the editable fields to change the configuration parameter.

• Clear your selections.

• Apply your selections.

• Undo the application of your selections.

You can expand or collapse the Multiple Port Configuration pane by clicking the Multiple Port
Configuration task bar. The Multiple Port Configuration pane is expanded by default.

The following figure displays the tabs available in the Edit, Chassis, Ports work flow, with the
Interface tab selected and the Multiple Port Configuration pane expanded.

Figure 12: Interface tab — Multiple Port Configuration pane expanded

The following figure displays the Edit, Chassis, Ports, Interface tab with the Multiple Port
Configuration pane collapsed.

Figure 13: Interface tab — Multiple Port Configuration pane collapsed

Changes you make to a port configuration using Multiple Port Configuration are applied to the switch
configuration only after you click Apply on the work area toolbar.

The following figure displays the location of the Apply button on the work area toolbar.
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Figure 14: Toolbar Apply button

Online help
Online help is context-sensitive and appears in a separate window in the Web browser.

To obtain help for the current topic, click the help button on the toolbar in the work area.

If you are not using EDM through COM, you need to download the help file to a TFTP server and
configure the EDM Help file path. For more information, see Configuring the path to the help files
using CLI on page 20.

Related links
Enterprise Device Manager (EDM) on page 33
Enterprise Device Manager (EDM) on page 33

Enterprise Device Manager procedures
This section contains procedures for starting and using Enterprise Device Manager (EDM) on your
switch. You can use EDM software on the switch; you do not need to install a client-based
application on your computer.

Starting EDM
To configure and maintain your switch through a Web-based graphical user interface, start EDM.

Before you begin
• Ensure that the switch is running.
• Note the switch IP address.
• Ensure that the Web server is enabled.
• Note the user name.
• Note the password.
• Open one of the supported Web browsers.
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Procedure
1. In a supported Web browser, enter the IP address of the switch using one of the following

formats:

• http://<IP Address>

• https://<IP Address>

2. Enter the user name.

3. Enter the password.

4. Click Log On.

Using shortcut menus
In the EDM Device Physical View you can use shortcut menus to edit objects and apply changes.

Procedure
1. In the Device Physical View, select an object.

2. Right-click the object.

3. Select a function from the list.

Shortcut menus field descriptions
Name Description
Unit
Edit Display the Edit unit dialog box and tabs
Refresh Refreshes switch status
Refresh Port Tooltips Refreshes the port tooltip data. Port tooltip data

contains: Slot/Port, PortName, and PortOperSpeed
Port
Edit Displays the Edit port dialog box and tabs
Graph Displays the graph port dialog box and tabs
Enable Enables the port administratively
Disable Shuts down the port administratively

Navigating around EDM
Use the following procedure to navigate around EDM.
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Procedure
1. In the navigation pane, click the arrowhead to the left of a folder to display the sub-level

folders in the tree.

2. If there is a sub-folder, double-click the folder or click the arrowhead beside it, to open the
sub-folder.

3. The primary tabs appear under the folders and sub-folders. Click a tab to open it in the work
area.

Undocking tabs
To improve certain types of configuration, you can view more than one tab at a time. To view more
than one tab, you use the undock function to activate a previously-opened tab from the menu bar.

Important:

When you undock a tab to make changes, then return to another open tab, in order to see the
effects of the changes, you must click the Refresh button on the tool bar.

Procedure
1. From the menu bar, drag and drop the tab you want to open.

2. To reposition the tab in the work area, click and drag the title bar of the tab.

Docking tabs
You can re-dock an undocked tab using one of the following methods.

Procedure
To re-dock a tab, do one of the following:

• On the undocked tab, click the dock-back button (the middle button on the top right of the panel)
• On the undocked tab, click the collapse button (left button on the top right of the panel) to

temporarily minimize the panel.

Editing a dialog box
Use this procedure to edit a dialog box.

Procedure
1. In the work area, double-click the field you want to edit.

2. Select a value from the list of predetermined values or enter the value for a field without
preset values.
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Important:

Enter an IP address in decimal format: <xxx> <xxx> <xxx> <xxx>.

Enter a MAC address in hexadecimal format: xx:xx:xx:xx:xx:xx.

Time is a value based on the delta from the switch boot-up time.

3. Click Apply.

Inserting an entry in a dialog box
Use this procedure to insert an entry in a dialog box.

Procedure
1. On the tool bar, click Insert.
2. Enter changes in the Insert dialog box.

3. Click Insert to submit the entry and return to the active tab in the work area.

4. On the toolbar, click Apply to commit the change to the configuration. The system refreshes
the view and errors display in a browser popup.

Deleting an entry from a dialog box
Use this procedure to delete an entry from a dialog box.

Procedure
1. Highlight the entry.

2. Click Delete.

Editing an object using the shortcut menu
You can edit objects in the Device Physical View from the navigation tree or the shortcut menu. Use
this procedure to edit an object using the shortcut menu.

About this task
Changes are not applied to the running configuration until you click Apply.

Procedure
1. On the Device Physical View, you can

• right click an object

• press Ctrl+click to select several objects, then right click
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• click and drag to select a group of objects, then right click

• click an entire device, then right click

2. From the list, click Edit.
3. Edit the applicable tab in the work area.

4. Click Apply.

Editing file system elements
Use this procedure to edit file system elements.

Procedure
1. Click the Edit arrowhead to open the Edit menu.

2. Double-click File System to open the File System tab in the work area.

File System work area field descriptions
The following table describes the tabs in the File System work area.

Tab Description
Config/Image/Diag file Use this tab to view information about and acquire

image, configuration, and firmware files.
Ascii Config File Use this tab to acquire ASCII configuration files.
Save Configuration Use this tab to save the current configuration

manually or automatically.

Configuring multiple interface ports using EDM - Example 1
Use this procedure as an example for configuring multiple interface ports using the Multiple Port
Configuration function and the Edit, Chassis, Ports, Interface work flow.

Before you begin
• Select ports on the Device Physical View.

Procedure
1. In the navigation tree, double-click Edit.
2. In the Edit tree, double-click Chassis.

3. In the Chassis tree, click Ports.

4. Click the Interface tab.
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5. To change the configuration of the selected ports, in the Multiple Port Configuration pane,
double-click the cell beneath the column heading that represents the parameter you want to
change and do one of the following:

• Select a value from a drop-down list.

• Type a value in the cell.

6. In the Make Selection pane, click Apply Selection. The changes appear in the table.

7. On the Interface tab toolbar, click Apply to apply the changes to the switch configuration.

Configuring multiple ports using EDM - Example 2
Use this procedure to configure multiple ports using the Multiple Port Configuration functions and
the Security, MAC Security, AutoLearn workflow. When you use this workflow you can select ports
directly from the Multiple Port Configuration pane on the Configuration tab.

Procedure
1. In the navigation tree, double-click Security.

2. In the Security tree, double-click MAC Security.

3. Click the AutoLearn tab.

4. In the work area, in the Make Selection section of the Multiple Port Configuration pane, click
the Switch/Stack/Ports ellipsis (...) to open the Port Editor dialog.

5. In the Port Editor window, click the ports you want to configure.

Note:

If you want to configure all ports, click All.
6. Click OK to return to the Make Selection pane.

The ports you selected appear in the Switch/Stack/Ports box.

7. To change the configuration of the selected ports, in the Multiple Port Configuration pane,
double-click the cell beneath the column heading that represents the parameter you want to
change and do one of the following:

• Select a value from a drop-down list.

• Type a value in the cell.

8. In the Make Selection pane, click Apply Selection.

The changes appear in the table.

9. On the AutoLearn tab toolbar, click Apply to apply the changes to the configuration.
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Graphing statistics
You can graph statistics for an entire device, a group of ports, or a single port.

Before you begin
On a Device Physical View select one of the following:

• a port
• a group of ports
• a device

Procedure
1. In the navigation tree, double-click Graph.

2. In the Graph tree, select one of the following:

• Chassis
• Port

3. In the work area, select a tab.

4. On the tab, select information to graph. To export the information to another application, on
the task bar click Export Data.

5. To create the graph, on the task bar, click a graph type.

Configuring the help file path using EDM
Use this procedure to configure the path to the help files.

Procedure
1. In the navigation tree, double-click Edit or click the Edit arrowhead to open the Edit menu.

2. Click File System to open the File System work area.

3. In the work area, click the Help File Path tab.

4. In the Path dialog box, enter the path to the help file storage location.

Example
tftp://A.B.C.D/file_name

Displaying USB file information using EDM
About this task
Displays the general information of the files on a USB flash device.
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Procedure
1. From the navigation tree, click Edit.
2. Click File System.

3. Click the USB Files tab.

Saving current configuration to flash memory manually using
EDM

Use this procedure to save the current configuration to flash memory manually.

Procedure
1. In the navigation tree, double-click Edit to open the Edit tree.

2. Double-click File System.

3. Click the Save Configuration tab.

4. Deselect AutosaveToNvramEnabled — this option is enabled by default.

5. In Action, choose copyConfigToNvram.

6. On the toolbar, click Apply.

Enterprise Device Manager configuration files
You can use Enterprise Device Manager procedures in the following sections to:

• store the current switch ASCII configuration on a TFTP server

• retrieve an ASCII configuration file from a TFTP server to apply to a switch

• store a binary configuration file from a TFTP server

• retrieve a binary configuration file from a TFTP server

• manually save the current configuration to flash memory

• designate a configuration to download automatically at switch startup

You can check file upload transfer status of ASCII configuration files in the ScriptLastStatusChange
field on the Edit > File System > Ascii Config Script Files tab. During upload
transfer, the status is manualUploadInProgress. To check changes to file transfer status, click
Refresh. After the file transfer is complete the status displays as either manualUploadPassed or
manualUploadFailed.

You can check file download transfer status of ASCII configuration files in the
ScriptLastStatusChange field on the Ascii Config Script Files tab. During download transfer, the
status is manualDownloadInProgress. To check changes to file transfer status, click Refresh.
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After the file transfer is complete, the status displays as either manualDownloadPassed or
manualDownloadFailed.

You can also designate an ASCII configuration file to download automatically at switch startup.

To control which ASCII configuration files load automatically, at switch startup use the fields in the
table on the Edit > File System > Ascii Config Script Files .

The Ascii Config Script Files table provides a way to control which ASCII configuration files are
loaded, and in which order, because you can designate the path to an ASCII configuration file, a
boot priority value, and a script index priority for each entry in the table.

Depending on which script source you designate for an entry, the system uses the designated paths
in the Ascii Config Script Files table in one of the following ways:

• The system uses BootP to download the designated ASCII configuration file from the network,
according to the specified IP address and file name.

• The system downloads the designated ASCII configuration file from a TFTP or SFTP server,
according to the specified IP address and file name.

• The system downloads the ASCII configuration file from a USB device, according to the
specified file name.

In the boot priority column on the Ascii Config Script Files tab, if you designate a non-zero boot
priority value for any but the first row, the switch attempts to load the configuration file at startup.
The first entry in the configuration files table is assigned a fixed boot priority value of 0 and it is not
available to load at startup.

The switch attempts to load each ASCII configuration file with a non-zero priority value, in ascending
order, until a script file loads successfully. If ASCII configuration file boot priority values are equal,
the switch attempts to load the configuration files according to their script index order.

In the Script Source column in the Ascii Config Script Files table, if you designate a USB device in
a stand-alone switch as the load-on-boot path to the ASCII configuration file, the switch downloads
the specified configuration file from the USB port of the switch.

If you designate a USB device in a stack unit as the load-on-boot path to the ASCII configuration file
entry, the system downloads the specified configuration file from the USB port of the designated unit
or, if no unit is designated, from the USB port of the base unit.

If the system cannot download the configuration file, or if the script does not execute successfully,
the script operational status changes to autoDownloadFailed and the system downloads the
next entry in the table.

When the configuration file downloads and executes without errors, the operational status for the
entry changes to autoDownloadPassed.
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ASCII and binary configuration file procedures
Perform the procedures in this section to use EDM to manage ASCII and binary configuration files.
For more information about fields on the Config/ImageDiag file tab, used to manage binary
configuration files, see Config Image Diag file tab field descriptions job aid on page 61.

Procedures for USB devices apply only to switch models equipped with USB ports.

Storing current ASCII configuration on a TFTP server using EDM
Procedure

1. From the navigation tree, double-click Edit to open the Edit tree.

2. Click File System.

3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type the TFTP server address and the configuration
file name in the following format:

tftp://<ip address>/<filename>
The entry is limited to a maximum of 327 characters.

5. Double-click the ScriptManual field and then click Upload.

6. On the toolbar, click Apply.

Storing current ASCII configuration on a SFTP server using EDM
Procedure

1. From the navigation tree, double-click Edit to open the Edit tree.

2. Click File System.

3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type the SFTP server address and the configuration
file name in the following format:

sftp://<ip address>/<filename>
The entry is limited to a maximum of 327 characters.

5. Double-click the ScriptManual field and then click Upload.

6. On the toolbar, click Apply.

Storing current ASCII configuration on a USB device using EDM
Procedure

1. From the navigation tree, double-click Edit to open the Edit tree.

2. Click File System.
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3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type:

usb://<filename> to store the configuration file on a USB device in a stand-alone unit

or

usb://<unit number>/<filename> to store the configuration file on a USB device in a
unit in a stack.

5. Double-click the ScriptManual field and then click Upload.

6. On the toolbar, click Apply.

Downloading an ASCII Configuration from a TFTP server using EDM
Procedure

1. From the navigation tree, double-click Edit to open the Edit tree.

2. Click File System.

3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type the TFTP server IP address and configuration
file name in the following format:

tftp://<ip address>/<filename>
5. Double-click the ScriptManual field and then click Download.

6. On the toolbar, click Apply.

Downloading an ASCII configuration from a SFTP server using EDM
Procedure

1. From the navigation tree, double-click Edit to open the Edit tree.

2. Click File System.

3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type the SFTP server IP address and configuration
file name in the following format:

sftp://<ip address>/<filename>
5. Double-click the ScriptManual field and then click Download.

6. On the toolbar, click Apply.

Downloading an ASCII configuration from a USB device using EDM
Procedure

1. From the navigation tree, double-click Edit to open the Edit tree.

2. Click File System.
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3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type the configuration file name in the following
format:

usb://<filename> for a USB device in a standalone unit

or

usb://<unit number>/<filename> for a USB device in a unit in a stack

5. Double-click the ScriptManual field, and then click Download.

6. On the toolbar, click Apply.

Downloading a configuration file automatically using EDM
Procedure

1. From the navigation tree, double-click Edit.
2. Click File System.

3. Click the Ascii Config Script Files tab.

4. Double-click the ScriptSource field and type the TFTP server IP address and the
configuration file name in the following format:

tftp://<ip address>/<filename>.

Substitute usb://<filename> to retrieve a configuration from a USB device in a stand-
alone unit or usb://<unit number>/<filename> if the USB device resides in a unit in a
stack.

If you retrieve the configuration file from a BOOTP server, type bootp:// in the
ScriptSource field.

5. Double-click the ScriptBootPriortity field and type a digit between 1 and 127 for the script
priority. Use 0 if you are not using the entry at startup.

6. On the toolbar, click Apply.

Storing a binary configuration file on a TFTP server using EDM
Procedure

1. From the navigation tree, double-click Edit.
2. Click File System.

3. Click the Config/Image/Diag file tab.

4. In the TftpServerInetAddressType dialog box, click the applicable address type button.

5. In the TftpServerInetAddress field, enter the TFTP server IP address.

6. In the BinaryConfigFilename field, enter the configuration file name.

7. In the BinaryConfigUnitNumber field enter the stack unit number or, for a stand-alone
switch, enter 0.
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8. In the Action box, click upldConfig.

9. On the toolbar, click Apply.

Storing a binary configuration file on a USB device using EDM
Procedure

1. From the navigation tree, double-click Edit .
2. Click File System.

3. Click the Config/Image/Diag file tab.

4. In the BinaryConfigFilename field, enter the configuration file name.

5. In the BinaryConfigUnitNumber field enter the stack unit number or, for a stand-alone
switch, enter 0.

6. In the UsbTargetUnit field, enter the stack number where the USB device is inserted.

7. In the Action field, click upldConfigtoUsb.

8. On the toolbar, click Apply.

Downloading a binary configuration file from a TFTP server using EDM
Procedure

1. From the navigation tree, double-click Edit.
2. Click File System.

3. Click the Config/Image/Diag file tab.

4. In the TftpServerInetAddress field, enter the TFTP server IP address.

5. In the BinaryConfigFilename field, enter the configuration file name.

6. In the BinaryConfigUnitNumber field, enter the stack unit number, or for a stand-alone
switch, enter 0.

7. In the Action field, click dnldConfig.

8. On the toolbar, click Apply.

Downloading a binary configuration file from a USB device using EDM
Procedure

1. From the navigation tree, double-click Edit.
2. Click File System.

3. Click the Config/Image/Diag file tab.

4. In the BinaryConfigFilename field, enter the configuration file name.

5. In the BinaryConfigUnitNumber field, enter the stack unit number, or for a stand-alone
switch, enter 0.
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6. In the UsbTargetUnit field, enter the stack unit number where the USB resides.

7. In the Action field, click dnldConfigFromUsb.

8. On the toolbar, click Apply.

Job aid—Config/Image/Diag file tab field descriptions
The following table provides information about fields on the Config/Image/Diag file tab.

Field name Description
TftpServerInetAddressType Specifies the IP version of the TFTP server address
TftpServerInetAddress Specifies the TFTP server IP address
BinaryConfigFilename Specifies the name of the binary configuration file
BinaryConfigUnitNumber Specifies the unit number of a switch in a stack
ImageFileName Specifies the software image file name
FWFileName(Diagnostics) Specifies the diagnostics file name
USBTargetUnit Specifies the unit number containing the USB port
Action • dnldConfigFromUSB—Downloads a configuration to the

switch from a USB device.

• DnldImgIfNewer—Downloads a new software image to the
switch only if it is newer than the current image.

• dnldFw—Downloads a new diagnostic software image to the
switch.

• dnldImgFromUsbNoReset —Downloads the diagnostic
image from a USB and does not reset the switch.

• dnldConfig—Downloads a configuration file to the switch.

• upldConfigToUsb—Uploads a configuration file to a USB
device.

• dnldImgNoReset—Downloads a new software image to the
switch without a switch reset.

• dnldFwNoReset—Downloads a new diagnostic software
image to the switch without a switch reset.

• upldConfig—Uploads a configuration file to the switch from a
designated location.

• dnldImg—Downloads a new software image to the switch.

• dnldImgFromUsb—Downloads a new software image to the
switch from a USB device.

• dnldFwFromUsb—Downloads a new diagnostic software
image to the switch from a USB device.

• dnldImgFromSftp—Downloads a new software image to the
switch from the SFTP server. This option replaces the

Table continues…
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Field name Description
software image on the switch regardless of whether it is
newer or older than the current image.

• dnldFwFromSftp—Downloads a new diagnostic software
image to the switch from the SFTP server. This option
replaces the image regardless of whether it is newer or older
than the current image.

• dnldConfigFromSftp—Downloads a configuration to the
switch from the SFTP server.

• upldConfigToSftp—Uploads a configuration to the SFTP
server.

• dnldImgFromSftpNoReset—Downloads the agent image
from a SFTP server anddoes not reset the switch.

• dnldFwFromSftpNoReset—Downloads the diagnostic
image from a SFTP server and does not reset the switch.

Status Displays the status of the most recent action since last switch
restart.

Getting EDM online help files for embedded EDM
Because help files are not included with the embedded EDM software files on the switch, you need
to download the help files to a TFTP destination and use CLI to configure a path from your switch to
the help files.

You can also use a USB mass storage device to contain help files for switches equipped with a USB
port.

If you are using COM to manage your switch, help resides with COM and you do not need to use
these procedures.

Downloading help files
Use this procedure to download help files.

Before you begin
• An available TFTP server — ensure that the TFTP path differs from the path you use to

download switch software.

Important:
Do not install EDM help files on Flash.

Enterprise Device Manager (EDM)
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Procedure
1. To obtain EDM help files for the embedded element manager, do one of the following;

• Go to https://extremeportal.force.com and locate the help file for the appropriate product.

• Select the help file from the software CD ROM contained in the Base Software License
Kit.

2. Download the help file to a TFTP server or a USB mass storage device.

Getting EDM online help files for embedded EDM
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